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1. Android fjf}

Android J& Google T 2007 4= 11 H 5 HE AT Linux V& I TFE T-H1#
ERG AR, 2 mBAERS. hafE. AP Sy /A, 5702
AN AR B) A $ T 3E 1 50 IE T RO SE 2L AL B R AF o vl AT e o B B AR i Linux
BT —A JAVA )52,

Android MFHEEAR PR, BEARATD BUAESEEESERWH, HX
T4 2 AR 4z Android IFRF AT LR JAVA TR, P EIEFINL (Virtual
Machine) Dalvik, HZE JAVA [f] bytecode ¥Rk H RS, o] 75 24}
25 SUN 5% JAVA (#2823 . Ak, Android JFAIEEZTFHE JDK 1.

2. Android MZE%E
Androidf M sk 4&: http://www. android. com/, HRIIARLLERE, Eoi k]
)4&: HPartnersiifigr: http://source. android. com/FlDevelopersiidisy:
http://developer. android. com/, KX & Tcikviml .
Androidff) ARG EKIE S % .
http://androidappdocs. appspot. com/sdk/requirements. html

METBCHT A IAndroid SDK F#k#s (ELIEMISDKIS &7 E 54 R4t , /b
A T0TE HE R M http://developer.android.com/sdk/index.html "~ #fr), T7&
AR T —ANHibkhttp: //androidappdocs. appspot. com/sdk/index. html, %
BEFE AU AT

Android SDK for Windows
android-sdk_r08-windows.zip
http://dl.google.com/android/android-sdk_r08-windows.zip
installer_r08-windows.exe (Recommended)
http://dl.google.com/android/installer_r08-windows.exe
Android SDK for Mac OS X (intel)
android-sdk_r08-mac_86.zip
http://dl.google.com/android/android-sdk_r08-mac_86.zip
Android SDK for Linux (i386)
android-sdk_r08-linux_86.tgz
http://dl.google.com/android/android-sdk_r08-linux_86.tgz
Here's an overview of the steps you must follow to set up the Android SDK:
1. Prepare your development computer and ensure it meets the system
requirements.
2. Install the SDK starter package from the table above. (If you're on Windows,
download the installer for help with the initial setup.)
3. Install the ADT Plugin for Eclipse (if you'll be developing in Eclipse).
4. Add Android platforms and other components to your SDK.
5. Explore the contents of the Android SDK (optional).
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3. MAETE

a. JDK 1.6

AR
http://www. oracle. com/technetwork/java/javase/downloads/index. html

AT A A Java SE 6 Update 23

INENLAS B g jdk1. 6.0 21, tH—FEH, s RS JDKL. 5 Bk
FATLL T .

b. Android SDK |##%

TEHEE B O T, DRI R RGIEREA R el . NER
windows 2003 server, K TF# 7T
http://dl.google.com/android/android-sdk_r08-windows.zip, < & H#f# L4680 ],

c. Eclipse IDE

Eclipse 3.4 (Ganymede) LAJ FRAI T o /NN T St A Y Helios (3.6)

—. JAVAIRIE
Windows Lt JAVA BREEASEA1 R
JAVA HOME
oA P SR VN 1 . | = = 8 o ol = B 0
|
TEE (H): TAVA HOME
FH{E (V) DY javahjdkl. 6.0_21
[ wWE ] [ Hoid ]
FIRTEE)
TE (11
FF_HO_HOST C... MO
JAVA_HOME D: % javahjdkl. 5.0_Dd E|
WUMEEE_OF FR... 1
oz Windows_ HT
Fath DM java JavaFXh javafu—=dlel . 3hbi. ..
gEw || B0 || #ko |
| wmE || B |
Path:


http://www.oracle.com/technetwork/java/javase/downloads/index.html
http://dl.google.com/android/android-sdk_r08-windows.zip
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x|

TR Fath

whin; %TAVA_HOME%hbin; D Yjavaieclipse

|

mE |

=. Android SDK %3t

Android SDK T] LLliiE SDK T#8% B3 FEAEE, EEMEE, FEE
BHREET; T MEB T E T4 SDK XX, FTRE, &8 MEN 2RI,

TEEEBIELT.

SDK T##s B3 FES U T

1. f#k4i android-sdk_r08-windows F##%, FFXUitiiz1T SDK Manager.exe:

& F:\android\android-sdk-windows

File Edit Wiew Favorites Tools  Help

@Back @ J l.ﬁ pSearch “. Folders v

address |23 Fi\android\android-sdk-windaws

v|Go

Mame Size | Twpe Date Maodified
File and Folder Tasks ) add-ans Falder 2011-1-30 11:38
@ Rename this file ) platforms Folder 2011-1-3011:38
. @tools Falder 2011-1-3011:38
(& Mave this file BN S0k Manager exe 354KE  Application 2010-11-17 18:51
Copy this file [£] 5ok Readme bt LKE Text Document 2010-11-30 19:34

&N Publish this file to the Weh
(=) E-mail this file
¢ Delete this file

Other Places

() android

My Documenks
:i Iy Computer
‘ﬂ [y Metwork Places

Details

SDK Manager.exe
Application

Date Modified: 2010811 B 17
B, 18:51

Size: 353 KB
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€ Android SDK and AVD Manager

Virkual Devi C i
s e POMPUIUMN W Refresh Sources

Available Packages
Settings d Installed Pacll  Fekching https: ffdl-ssl. google. comfandroid/repository repository, xml

About 1 sndroid sij [n--n---n-n---nn--n-nn--n-nn--n-nn-nn-n--n-----]

i DK Platfo
& SDK, Platfo Failed ko Febch URL https:Il'll'dl—ssl_.gc-ogle.c-:rnIl'andrc-idIrepositorw‘repositorv:xml,
i reason: HTTPS S50 error. You might want to Force download through HTTP in the
" SDK Platfo settings

Description

Update All... Delete. .,

T setting 1%+ Force https://... Sources to be fetched by using http://... )ik
THT 2

@ Android SDK and AVD Manager

Wirkual Devices
Installed Packages

Arvailable Packaies HTTP Proscy Server | |

About HTTP Prowy Pork | |

Proxy Setkings

Misc
| [“Farce https:fi... sources b be Fetched using httpyff...  Bhttp=lEER 1 Akt tpiElE |
sk before restarting ADE

Save & Apply

2. AJIERAE 235K Packages, Jfs5ili Install Selected AT 4%
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3 Android SDK and AVD Manager

Wirtual devices SDK Location: F:handroidiandr oid-sdk-windows
Installed packages
B

Packages available For download

]

Android Repository

] I Android SDK Tools, revision 9

¥ android SDK Platfarm-tools, revision 2

Documentation For Android 'Honeycomb' Preview SDK, revision 1

About

[

S0k Platform Android Honeycomb Preview, revision 1
S0k Platform Android 2.5.1, APT 9, revision 2

SDK Platform Android 2.2, AP &, revision 2

SDK Platform Android 2.1, APT 7, revision 2

SDFK Platform Android 1.6, AP 4, revision 3

SOk Platform Android 1.5, AP 3, revision 4

& Samples For SDK APT Honeycomb Preview, revision 1

O
O
O
O

& Samples for SDK APT 9, revision 1
O & Samples For SDK APT 8, revision 1

Samples For

1 [ P B Y Y R A 0 2

W Google Inc. add-ons (di-ssl. google. cam)

'if. Google APIs by Google Inc., Android AP 9, revision 2

'Ef. Google APIs by Google Inc., Android AP 9, revision 1

O 'E;. Google APIs by Google Inc., Android API 8, revision 2

O 'Ef. Google APIs by Google Inc., Android API 7, revision 1

O 'E‘. Google APIs by Google Inc., Android APT 4, revision 2

O 'ﬁ. Google APIs by Google Inc., Android APT 3, revision 3
@ Google Ush Driver package, revision 4

m Gongle Market Licensing package, revision 1

2] a Samsung Electronics add-ons {innovator, samsungmobilz, com)
-] 'Ef. GALARY Tab by Samsung Electronics., Andraid APT &, revision 1

[ A

[

Description
Android SDK Samples for Android APT 7, revision 1

Add Add-on Site... Display updates only Install Selected

3. FRUEHERHEDN R, 2EF% Accept All FEAT R 822

% Choose Packages to Install

Packages Package Description & License
" SDK Platform Android 2.3.1, APT 9, revision 2 [*] Packaqe Description ~
~ Samples for SOK APL 9, revision 1 .ﬁ.nd_ro_id SDK Platform 2.3.1_r2 T
" Google APIs by Google Inc., Android API 9, rev... REHETE &
" Google Usb Driver package, revision 4 Dependencies
~ Google Market Licensing package, revision 1 This package is 4 dependency for:

- Google APIs by Google Inc., Android APT 9, revision 2

Archive Description

Archive For any 05

Size: 75 M

SHA1: 209f8a7agb2cb093fce858babeSfed3bas 206773

Site
andrnid Rennsitary (dl-=s1.nanale . ram

O Accept D Reject

Inskall H Cancel ]

4. I Android SDK #2810 N #2228 ) il F
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B Installing Archives @

Downloading S0 Platform android 2.3.1, APT 9, revision 2 (1%, 356 KiB's, 3 minutes lef

[ | [ Cancel |

Downlaading SOK Platform Andraid 2.3.1, API 9, revision 2

5. MRAEVRE MO, F BRI N T s Bk, 1S I OS54

FEHTESBNT:

1. @S HrAndroid &2 1
http://dl-ssl.google.com/android/repository/repository.xml Py 2%, 7] LL1S 2140
T R#E4E (LLWindowsI R 4]

http://dl-ssl.google.com/android/repository/android-1.5_rO4-windows.zip
http://dl-ssl.google.com/android/repository/android-1.6_r03-windows.zip
http://dl-ssl.google.com/android/repository/android-2.0_rO1-windows.zip
http://dl-ssl.google.com/android/repository/android-2.0.1_rO1-windows.zip
http://dl-ssl.google.com/android/repository/android-2.1_r02-windows.zip
http://dl-ssl.google.com/android/repository/android-2.2_r02-windows.zip
http://dl-ssl.google.com/android/repository/android-2.3.1_r02-linux.zip
http://dl-ssl.google.com/android/repository/android-3.0_pre_r01-linux.zip
http://dl-ssl.google.com/android/repository/platform-tools_r02-windows.zip
http://dl-ssl.google.com/android/repository/tools_r09-windows.zip
http://dl-ssl.google.com/android/repository/docs-Honeycomb_pre_rO1-linux.zip
http://dl-ssl.google.com/android/repository/samples-Honeycomb_pre_rO1-linux.zip
http://dl-ssl.google.com/android/repository/samples-2.1_rO1-linux.zip
http://dl-ssl.google.com/android/repository/samples-2.2_r01-linux.zip
http://dl-ssl.google.com/android/repository/samples-2.3_r01-linux.zip

2. AEHI N ECCR NI, I R OC R iR IS 40 B SDK R 34t Pt
FEH S, WU ISR

android-1.5_r04-windows.zip platforms\android-3
android-1.6_r03-windows.zip platforms\android-4
android-2.0_r01-windows.zip platforms\android-5
android-2.0.1_r01-windows.zip platforms\android-6
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android-2.1_r02-windows.zip

platforms\android-7

android-2.2_r02-windows.zip

platforms\android-8

android-2.3.1_r02-linux.zip

platforms\android-9

android-3.0_pre_r01-linux.zip

platforms\android-10

platform-tools_r02-windows.zip

platforms-tools

tools_r09-windows.zip tools

docs-Honeycomb_pre_rO1-linux.zip doc

samples-Honeycomb_pre_r01-linux.zip

samples\android-10

samples-2.1_r01-linux.zip

samples\android-7

samples-2.2_r01-linux.zip

samples\android-8

samples-2.3_r01-linux.zip

samples\android-9

3. W E e Higoogle api, AT N E PR ML
http://dl-ssl.google.com/android/repository/addon.xml % H 75 2L K

PackagesiFAT ik, J7ikA 1. 2

% Android SDK and AVD Manager

WA e B

uml.org.cn

Yirtual devices
Installed packages
Available packages
Settings

About

SDK Location: F:landroidiandroid-sdk-windows

Packages available For download
E-[#] = android Repository

I android DK Taals, revision 9

[

L B 1 1 B 1 O 1 B 1y O
EEEEEEIE

[ R

[ )

ol
]

R 'Ej. Google APIs by Google Inc,
[] & Google APIs by Google Inc.
[ ] ¢ Google ARTs by Google Ine,
[ ] & Google &PTs by Google Ine,
[ ] ¢ Google ARTs by Google Ine,
#-[] & Google 4PTs by Google Ine,
-] =] Google Usb Driver package, revision 4

=] Dm Google Market Licensing package, revision 1

-] ﬂ Samsung Electronics add-ons {innovator.samsungmobile, com)

@] 'E]. GALAXY Tab by Samsung Electronics., Android APT 8, revision 1

i Documentation For Android 'Honevcamb' Preview SOK, revision 1
SDK Platform Android Honeycomb Preview, revision 1
30K Platform Android 2.3.1, API 9, revision 2
SDK Platform Android 2.2, APT 8, revision 2
30K Platform Android 2.1, API 7, revision 2
SDK Platform Android 1.6, APT 4, revision 3
SOK PlatForm Android 1.5, API 3, revision 4

& Samples for SDK APT Honeycomb Preview, revision 1

& Samples for SOE APT 9, revision 1

& Samples for SOK APT &, revision 1

& Samples Far SDE AP 7, revision 1

, Android APT 9, revision 2
, Android APL 9, revision 1
, Android API 3, revision 2
, Android APT 7, revision 1
, Android APT 4, revision 2
, Android APT 3, revision 3

Descripkion
Add-on Provider: Google Inc, add-ons

[Add-on URL: https:[fdl-ssl.google. com/androidfrepasitary faddon, xrml |

Add Add-on Site. ..

Display updates only [ReFresh ] [Install Selected

NESIRN:

http://dl-ssl.google.com/android/repository/google_apis-3-r03.zip
http://dl-ssl.google.com/android/repository/google_apis-4_r02.zip
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http://dl-ssl.google.com/android/repository/google_apis-5_r01.zip
http://dl-ssl.google.com/android/repository/google_apis-6_r01.zip
http://dl-ssl.google.com/android/repository/google_apis-7_r01.zip
http://dl-ssl.google.com/android/repository/google_apis-8 r02.zip
http://dl-ssl.google.com/android/repository/google_apis-9_r02.zip
http://dl-ssl.google.com/android/repository/market_licensing-r01.zip
http://dl-ssl.google.com/android/repository/usb_driver_r04-windows.zip

4. WUNRAN:

google_apis-3-r03.zip add-ons\addon_google_apis_google_inc_3
google_apis-4_r02.zip add-ons\addon_google apis_google inc_4
google_apis-5_r01.zip add-ons\addon_google_apis_google _inc_5
google_apis-6_r01.zip add-ons\addon_google apis_google _inc 6
google_apis-7_r01.zip add-ons\addon_google_apis_google_inc_7
google_apis-8 r02.zip add-ons\addon_google_apis_google_inc_8
google_apis-9_r02.zip add-ons\addon_google _apis_google_inc_9
market_licensing-r01.zip google-market_licensing
usb_driver_r04-windows.zip | usb_driver

5. FARMN H 4ty ~ A
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= I3 android-sdk-windows
= |2) add-ons

¥

| # F

F

|Z) addon_google_apis_google_inc_3
|2) addon_google_apis_google_inc_4
|} addon_google_apis_google_inc_S
|2 addon_google_apis_google_inc_&
|) addon_google_apis_google_inc_7
|2 addon_google_apis_google_inc_&
|) addon_google_apis_google_inc_9

+ ) docs
+ ) google-market_licensing
= I} platforms

F

e

|) android-3
|2 android-4
) android-5
|Z) android-a
|2) android-7
|Z) android-g
|2) android-2
+ ) data
) images
+ ) skins
IZ) templates
+ | ) tools
|2 android-10

+ ) platform-tools
=l I} samples

F

Fe

F

¥

|2) android-7
|2 android-g
=) android-2
|2 android-10

# | ) kemp
+ ) tools
+ |2 usb_driver

x

Tarne Size

~ |yadd-ons

|[idocs
| ZJgoogle-market_licensing
|Zplatforms
|[aplatform-tools
|Z)=samples
|[temp
|[ZJtools
|[ZJusb_driver

S0K Manager.exe
[Z] =Dk Readme bxt

354 KB
1 KB

Type
Folder
Folder
Folder
Folder
Folder
Folder
Folder
Folder
Folder
Application
Text Docurment

Date Modified
2011-1-30 1447
2011-1-3015:02
2011-1-3015:05
2011-1-3015:06
2011-1-3011:51
2011-1-30 14:49
Z2011-1-3015:05
2011-1-30 14:47
2010-12-6 20047
2010-11-17 18:51
2010-11-30 19:34

6. fRI5CJE BN~ SDK FMalids, R & 23k, anhE:
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% Android SDK and AVD Manager =1E]

virtual devices SDK Location: F:landroid|andraid-sdk-windows
fevailable packages Installed packages

Sekki

nebnﬂgs I Android SOK Tools, revision 9

¥ Android SDK Platform-toals, revision 2

it Docurnentation For Android 'Honeycomb' Preview SDE, revision 1

SOK, PlatForm Android 2.3.1, APL 9, revision 2

SOK, PlatForm Android 2.2, APT &, revision 2

SDK Platform Android 2. 1-updatel, APT 7, revision 2

SDK Platform Android 2.0.1, API 6, revision 1

SDK Platform android 2.0, APT S, revision 1

SDK PlatForm Android 1.6, APT 4, revision 3

SDK, PlakForm Android 1.5, APT 3, revision 4
db Samples For SDK API Honeycomb Preview, revision 1
& Samples For SOK APL 9, revision 1
& Samples For SDK AP 8, revision 1
& Samples For SDK APL 7, rewvision 1
'E]..Gu:u:ugle APIs by Google Inc,, Android APT 9, revision 2
'E.ch:ugle APIs by Google Inc,, Android AP &, revision 2
'E.Google APIs by Google Inc., Android APT 7, revision 1
'E.Google APIs by Google Inc., Android APT &, revision 1
'E.Google APIs by Google Inc., Android APT 5, revision 1
'E].Google APIs by Google Inc., Android APT 4, revision 2
'E].Gaagle APIs by Google Inc,, Android APT 3, revision 3
58 Ush Driver package, revision 4
=1 Google Market Licensing package, revision 1

Cescripkion

Update all...

Ve I P EFF G IR, Android A/ 7 Android SDK Platform
Honeycomb Preview, revision 1, /441 # #% android-3.0_pre_r01-linux.zip (7%
http://dl-ssl.google.com/android/repository/android-3.0_pre_r01-linux.zip, ZrL{ Z7H#/
LT XA Android SDK, /4405 SDK /. 15 5107 77 T # %
Fo

PU. Eclipse £ERJF &K (IDE) ##

HLAE T4 Eclipse IDE & Android Eclipse plugin ()25 FIRc &, 3% HLA8 1)
Eclipse 4, eclipse-java-helios-SR1-win32.zip, i 4473 Eclipse ‘B J5 ®
(http://eclipse.org) b R & A O MK RRAS, #i% 3.4 DL EFRA.

AT A K Android Eclipse Plugin & ADT: Android Development Tools.
Al Android SDK —#¥, 2 ATELRZEM T3 ZIPIF TR .

LRI BT

1. FI7F Eclipse, LK H.: Help->Install New Software...

10
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YWeloome
(7) Help Contents

&7 search
Crynamic Help

Key Assist... Zkrl+Shift+L

Tips and Tricks, ..
E}" Repart Bug or Enhancement. ..
Cheat sheets. .,

Check for Updates

Inskall Mew Software. .,

Eclipse Marketplace. ..

about Eclipse

2. B “Available Software” %fifHE, A “Add..” %

& Install

Available Software

Select a site or enter the location of a site,

- B)X]

o

ok with:ﬁ Lvpe or selec

S

Find more software by working with the "Available Software Sikes” preferences,

Mame
| (1) There is no site selected.

Version

Select all ] [ Deselect Al

Dietkails

Show only the latest versions of available software

Group items by category

@

[THide items that are already installed

What is already installedr?

Conkact all update sites during install to find required software

< Back Mext = Finish

Zancel

11
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3. P “Add Repository” XJifHE.

Name F4@ A: ADT

Location "% A\ :  https:/dl-ssl.google.com/android/eclipse/, SRR https
Al # N\ http://dl-ssl.google.com/android/eclipse/

LINNEE

& Add Repository E|
ame: |F'.DT | [ Local... ]
Location: |htt|:u|:,|',|'u:||-ssl.gu:n:ugle.cu:um,l'andru:uid,l'eclipse,l' | [ archive, .. ]

® [ ok H Cancel ]

st “OK” 254,

4. I Eclipse M ZRFEE URL 756, iz ok, ~HI: Developer
Tools [JSIEMNE, EFLEEME, T “Next” $24l.

12



ME% . 2233
= = uml.org.cn

no Pain no Gain no Gavin & [F>P T Hr 4. http://blog.sina.com.cn/deaboway http://blog.csdn.net/deaboway

& Install |-_||'E|[$__<|
Available Software
heck the items that wau wish to install, —
=
Wark with:  |[&DT - https:ffdl-ssl. google. comjandroidfeclipse, w | [ add.., ]

Find more software by working with the "Available Software Sikes” preferences,

Mame Versian
= [w]000 Developer Tools
% Android DOMS 9.0,0,%201101191456-935220
% Android Developrment Tools 9.0.0.v201101191456-93220
% Android Hierarchy Viewer 9,0,0,v201101191456-33220
Select all ] [ Deselect Al 3 items selected
Dekails
Show only the latest versions of available software [THide items that are already installed
Group items by category What is already installed?

Conkact all update sites during install to find required software

©

5. HIL “Install Details” X 1EHE, rih “Next” 4.

13
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& Install |:|E]

Install Details
Review the items ko be installed, =
=
Mame Version Id
% Android DOMS 9,0.0.%2011011.., com.android.ide.eclipse,ddms . Featur. ..
% Android Development Toals 9,0.0.+2011011... com.android.ide.eclipse, adt.Feature. ...
% Android Hierarchy Viewer 9.0.0.+2011011... com.android.ide.eclipse. hierarchyvie. ..
< | >
Size: Unknown
Dietkails
@ oo ]

6. HIL “Review Licenses” XII&HHE, ZEF: “1 accept the terms of the license
agreements” SIEME. At “Finish” 4%

14
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& Install |:|E]

Review Licenses
Licenses must be reviewed and accepted befare the software can be installed. D -

Licenses: License texk:

Apache License
Mote: joommon-1.0.12.jar is under the B3D license rather thal
Mote: kxmlz-2.3.0.jar is under the BSD license rather than the

{(*1 accept the kerms of the license agreements:

{31 do not accept the kerms of the license agreement:

[
I

@ Mexk = Finish ] [ Zancel

7. BEN N R R

& Installing Software

i J Installing Software

(RERNRNRNRWRANRNRRRAE )

Fetching com,android.ide.eclipse.ddms_, . .pse.ddms_9.0.0,v201101191456-93220, jar

[ ialwayvs run in backaround:

[Run in Eau:kgru:uund] [ Cancel ] [ Details == ]

8. HREP I RES I “Security Warning” XFiEHE, A0 AT “OK” %
GRS
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& Security Warning |:||E| [z|

Wharning: You are installing software that contains unsigned conkent, The
! authenticity or validity of this software cannok be established, Do wou want ko
continue with the installation?

| ok || cancel || pstaiszs |

0. WHHINIE, WU Eclipse, WISIHIEA OB,
& Software Updates b—q

y fou will need to restart Eclipse For the installation changes to take effect. You
x__'\"j maty try ko apply the changes without reskarting, but this may cause errors,

m.gstart Tl | [ ok Mo ] [ﬂpply Changes How

BERELBEINT

1. 5 http://androidappdocs.appspot.com/sdk/eclipse-adt.html 3R 4 Hij Fe 6T
A ADT - Eclipse B2k 220, HATEOfT A . ADT 9.0.0, 4
Huhik k. http://dl.google.com/android/ADT_9.0.0.zip

2. T4 Eclipse Plugin (AR Z22& 5t #EHd, Wi o BT 2N RE IR AR 26 20 2%
KL, BARA PR,

& Add Repository E'

Mame: |F'.DT |  Local., |

Location: |jar:File:,I'F:,l'andru:uid,l'.ﬁ.DT_'El.D.El.zip!,l' | [ archive, .. ]
@::l (0.4 ] [ Cancel ]

Fi. Eclipse ADT Bii &

ADT [ Eclipse Plugin &3tz J5, JF4h ADT ECE, HEA4AWT:
1. Eclipse )3 J&, #£# Window > Preferences..., 7E4] T JETEHE, %EF
Android, nJ DL F):
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& Preferences

| | @ Value must be an existing directary = —

General
Android
ank SOk Location: | [ Browse. ..
Help
Install/Update
Java Target Mame Wendar Flatform  &P...
RunDebug

Tasks

Team

IUzage Data Collector
Yalidation

#ML

android Preferences

Mote: The list of SDK Targets below is only reloaded once wou hik *apply' or 'Ok

L e B B AR

(&3]

Restare Defaults Apply

@ o« [Cam ]

2. {f SDK location F 4 AR[%) Android SDK FITZE [ H 5%, #RJ5 4% Apply
fetl RIA] A 2I3RAT 2% SDK 4, W H K.
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& Preferences

@

B=1E

Android
ii;re;z: android Preferences
ank SDK Location: |F:'l,andruid'l,andruid-sdk—windows | [ Browse. ..
Help Mote: The list of SDK Targets below is only reloaded once wou hik *apply' or 'Ok
Install/Update
Java Target Mame Yendar Platform | &P..,
Run/Debug Android 1.5 Android Open Source Project 1.5 3
Tasks Google APIs Google Inc, 1.5 3
Tean Android 1.6 Android Open Source Project 1.6 4
Usage Diata Colleckar Google APIs Google Inc, 1.6 4
Validatian .ﬁ.ndrTid 2.0 .ﬁ.ndrTid Cpen Source Project 2.0 5
Google APIs Google Inc, 2.0 5
AML Android 2.0.1 Andraid Open Source Project 2.0.1 &
Google APIs Google Inc. 2.0.1 &
android 2. 1-updatel Android Open Source Project Z1-up... 7
Google &PIs Google Inc, z.1-up.. 7
android 2.2 android Open Source Project 2.2 g
Google APIs Google Inc, 2.2 g
Android 2.3.1 Andraoid Open Source Project 2.3.1 9
Google APIs Google Inc. 2.3.1 9

Standard Android platForm 1.6

[Resture Defaults ] [

Apply

]

I

O l [ Zancel

]

2k, Eclipse+ADT ¥4 T A B8 w2 B e B e EE

A TN
VAR

Android SDK At &

XHEAE R AVD. iTiE AVD, Hl Android Virtual Devices , Android &

B, IREHRA ST A b H RS o

1. 7 Eclipse FFi%+% Window-Android SDK and AVD Manager , &7
android-sdk-windows 3Cf1 32 o X iy SDK Manager.exe, 1] LAE 128040 F

e
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% Android SDK and AVD Manager

Wi a5
Installed packages

List of existing sndraid Yirkual Devices located at C:iDocuments and Settings)Administratary, androidiawd

Available packages YD Name Target Narme Platform API Level Mew, ..,
" gavin Android 2.2 2.2 g =
IC. ..
' rrmapi Android 2.2 2.2 g
Delete. ..
Repair,..
Details. ..
Start...

Refrash

s B valid Android Virkual Device, A repairable Andraid Yirkual Device,
¥ An Android Yirkual Device that Failed to load, Click ‘Details' to see the errar,

Ve X A LUE BN CZCIES BT AVD, H LA AVD AR
22 Fe /9 Android SDK 774 &1, 1HAZ i1 TP 19 AND A B 7 43 A8 17 1 2
AT/ 9 home 7, 4p7: C:\Documents and Settings\Administrator\.android\avd .
Pl X ] LU 2

2. fE9HIfY) Android SDK and AVD Manager XfifHE, ##% Virtual Devices,
i new FH QIR BRI S, MW FEIFR:

19
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& Create new Android Virtual Devic

e (AVD)

Mame:; |.ﬁ.ndrnid9-.ﬁ.'u'D

Target: | Android 2.3.1 - API Level 9

S0 Card:
@ size: 100 | [MiE |
) File: | | Browse. ..
Snapshot;
[ ]Enabled
Skir:
(%) Built-in: | Default (WYEASO0)
() Resolution: | | ® | |
Hardware:
Property Walue Mew, ..
Abstracked LCD density 240
Max WM application heap size 24 Delete
Crverride the existing AYD with the same name
Creake AWD l [ Cancel

M
/]
+

e Target: SDK [#)27
e SDcard: SD Kk
o Skin: HEIR5EIIZEA

3. il “Create AVD” #4l, W e3Eish, <48 “Android SDK and AVD

Manager” X iEHEH EoR,

20
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% Android SDK and AVD Manager

List of existing sndraid Yirkual Devices located at C:iDocuments and Settings)Administratary, androidiawd

Installedpackages
Available packages AYD Mame Target Name Platfarm AP Level
" gavin Android 2.2 2.2 g =
IC. ..
' rrmapi Android 2.2 2.2 g
" Bndroid3-avD Android 2,3.1 2,31 3 Delete. .
Repair,..
Details. ..
Start...

Refrash

s B valid Android Virkual Device, A repairable Andraid Yirkual Device,

¥ An Android Yirkual Device that Failed to load, Click ‘Details' to see the errar,

RUETF RN E 58, #6T REITAT LABEAT Android BN T TT 4 o

+. ZE— Android M (Hello, Android World!)

1. BramiH: $7JF Eclipse, #%#¢ File > New > Project > Android Project, H.

PRI AT &
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& New Android Project |._| .E”z'
Mew Android Project
Creates a new Android Project resource,
Project name: |HelloAndroidwiorld
Zonkents
@ Create new project in workspace
{:!' Create project from existing source
Use default location
() Create project from existing sample
Samples:
Build Target
Targek Mame Wendor Platform fi1=)
] android 1.5 Android Open Source Project 1.5 3
[] coogle APIs @oogle Inc. 1.5 3
[] android 1.6 Android Open Source Project 1.6 4
[] coogle APIs @oogle Inc. 1.6 4
[] android 2.0 Android Open Source Project 2.0 5
[] Google APIs Google Inc, 2.0 5
[] android 2.001 android Open Source Project 2.0.1 &
[] Google APIs Google Inc. 2.0.1 &
[] android 2.1-updatel  Android Open Source Project 21-upd... 7
[] coogle APIs Google Inc, 21-upd... 7
[] android 2.2 Android Open Source Project 2.2 g
[] coogle APIs @oogle Inc. 2.2 G
Android 2.3.1 Android Open Source Project 2,31 a
[] Google APIs Google Inc, 2,31 a
standard Android platform 2.3.1
Properties
application name: |He||n:n.ﬁ.ndrc'i|:|w:|rld |
Package name: |nrg.deahnway.test |
Create Activiky: |Hella.ﬁ.ndraidWDrld |
Min SOk Version: | |
3
@J [ < Back ][ Mext = ] [ Einish ] [ Zancel

2. pith “Next” , $&7rtnb:

22
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& New Android Project

Mew Android Test Project

Creates a new dndroid Test Project resource,

[ licreate a Test Project!

Conkent

Idse default location

Browse, ..
Tesk Targek
Build Target
Targek Mame Wendaor Platform AP,
L]
L]
L]
L]
L]
L]
L]
L]
L]
L]
L]
L]
L]
]
Properties

® lext = [ Einish H Cancel ]

3. XHEACHE R, AREMWRAIH . HE A “Finish” $HIRIA,
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& Java - HelloAndroidWorld/src/org/deaboway/test/HelloAndroidWorld. java - Eclipse

File Edit Run Source Refactor Mavigate Search Project  window Help

1 (il B B 0 Q- = C A Nr=a 7 |8 1ava |
¥ 8 :
Package Explor o= Qutline HelladndraidWaorld java
[2 packa lor &3 OF Outl = B || 3] Heloandraidworld ot =B
= <}'=={> o = package org.deshoway.test; =
' El

= & Helloandroidwaorld :
e - #®import android.app.ictivicy;[]

=4 org.deaboway kest
public class HellolndroidWorld extends Activicy |
J*%% Called when the activity iz first created. */
ACverride

2a gen [Generated Java Files]
B Android 2,31

a@ assets public void onCreate (Bundle savedlInstanceltate) |
a@ res super.onCreate (savedInstance3tate)] ;

A AndroidManiFest.ml setContentView (B, layout .maix) }

defaulk, properties
|=| proguard.cfg

[34 Problems &2 @ Javadoc @) Dieclaration & -~ O
0 items

Description Resource Path Locak...  Typ
< | >

njd org.deaboway kest.HelloAndroidWorld, java - Hellogndroidwiorld sre

4. %48 HelloAndroidWorld.java SC£F, WA

package org.deaboway.test;

import android.app.Activity;
import android.os.Bundle;
import android.widget.TextView;

public class HelloAndroidWorld extends Activity {

/** Called when the activity is first created. */

@Ooverride

public void onCreate(Bundle savedlnstanceState) {
super .onCreate(savedInstanceState);
TextView textView = new TextView(this);
textView.setText("'Hello Android World!');
setContentView(textView);

24
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5. 1247 Android T H : sl T RS T, sERER . Run->Run, 8%
A BT H SO, i “Run As” XHEHE, 1EH “ Android Application”
st “OK” $ifll

& Run As |:|@

Select a way to run ‘Hellodndroiditorld':

[Eliandroid Application:
Jii android JUnit Test
Java Applet

3] Java Application

Ju JUnit Test

Description

©

6. IZATHURWIT, AVD INBHE AT LN, T 0554 .
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B 5554: Android9-AVD

= ol B 442

HelloAndroidWorld
Hello Android World!

7. [FII}, Eclipse [ ] & T ENHISATIN (K —LEARSCAE B, Wik
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& Java - Eclipse

File Edit Run Mavigate Search Project Refactor Window Help
- Brldid-0-Q- HE- dG - B & gava |
o o v
[2ll Problems | @ Javadac Eﬁ';.DecIaration El console 3 BBl ABE-5- 7%
® android . _ _ - _
m [2011-01-30 16:03:47 - 3DE Manager] Warning: Ignoring platform 'android-10': build.prop is
EE [2011-01-30 16:09:04 - 3DE Manager] Warning: Ignoring platform 'android-10': build.prop is
[2011-01-30 16:11:29 - 3DK Manager] Warning: Ignoring platform 'android-10': build.prop is
[2011-01-30 16:15:40 - 3DE Manager] Created AVD 'Android9-AVD' based on Android 2.3.1,
[2011-01-30 16:158:40 - 3DE Manager] with the following hardware config:
[2011-01-30 16:15:40 - 3DE Manager] hw.led.density=240
[2011-01-30 16:158:40 - ADEK Manager] vm.heaplize=2Z4
[2011-01-30 16:37:25 - HellohndroidWorld] ----——————-—-———-———-—————————————
[2011-01-30 16:37:25 - HellobndroidWorld] Android Launch!
[2011-01-30 16:37:25 - HellohindroidWorld] =adb i=s running normally.
[2011-01-30 16:37:25 - HellobndroidWorld] Perforwming org.deasboway.test.HellobndroidiWorld a
[2011-01-30 16:37:25 - HellohndroidWorld] Automatic Target Mode: launching new emulator wi
[2011-01-30 16:37:25 - HellobndroidWorld] Launching a new ewulator with Virtual Device 'An
[2011-01-30 16:37:33 - HelloindroidWorld] New emulstor found: emulator-5554
[2011-01-30 16:37:33 - HellobindroidWorld] Waiting for HOME ('android.process.acore') to be
[2011-01-30 16:35:42 - HellohindroidWorld] WARNING: Application doe=s not specify an API lew
[2011-01-30 18:368:42 = HellodndroidiWiorld] Dbewise APT wersliom I3 9 (Androdd Z:3:1)
[2011-01-30 16:35:42 - HelloindroidWorld] HOHME is up on device 'emxulator-5554!
[2011-01-30 16:358:42 - HellobndroidWorld] Uploading HelloAndroidWorld.apk onto device 'emu
[2011-01-30 1g:358:42 - HellohndroidWorld] Installing HellolndroidWorld.apk...
[2011-01-30 16:39:34 - HellobndroidWorld] Success!
[2011-01-30 16:39:34 - HellohndroidWorld] Starting activity org.desboway.test.HellolAndroid
[2011-01-30 16:39:38 - HelloindroidWorld] ActivityManager: 3tarting: Intent { act=android.
35 >
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